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Introduction
Xfrog is a modeling and animation system specializing in the easy 
generation and animation of complex organic structures. There are two 
versions of Xfrog available: The Full version and the Lite version. The Xfrog 
Full version comprises all features of Xfrog including animation capabilities. 
Xfrog Lite version does not provide animation functionality. 
Xfrog combines the creation of normal geometric objects (the primitives) 
with information on how this geometry is organized (the component 
hierarchy). With Xfrog you have primitives, such as cubes, spheres etc. and 
components, such as phiball, tree, etc. which together provide a hierarchical 
structure. The components embody algorithmic descriptions of objects that 
can be found in nature, such as tree branches, leaves, or sea shells, 
jellyfish, etc. By combining different components and assigning specific 
values to the components it is easy to create complex objects that follow 
their natural examples. You can build almost any tree found in Nature, 
or flowers, houseplants, etc. As well, you can use Xfrog for architectural 
sketches and abstract organic artwork.
Xfrog uses a procedural graph network approach that allows you to link 
different components together and, thus easily link components which affect 
each other and together build a hierarchical organic structure. All values of 
all components may as well be animated - such as a flower blossoming, or a 
tree growing and changing over time. 

System requirements
PC with minimum 400 mhz processor, OpenGL graphics support, 256 or 
higher RAM. Xfrog will run in PC emulation modes on Mac, Xfrog also 
runs on IRIX and Linux operating systems, contact us for the appropriate 
download.

Installing Xfrog
Unpack the downloaded Xfrog35.zip and launch the automatic installer by 
double clicking the “Setup” Icon. Specify the location on your hard disc 
where you want Xfrog installed and choose an installation option. “Typical” 
will install the Xfrog application, help files and a number of demo models 
showing you the architecture of Xfrog models and an uninstall log for 
convenient deinstallation. 
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Main Window

Xfrog always opens in the main window which provides the main menu. 
The main window is subdivided into the sub windows “Hierarchy”, “Model 
View”, Parameter Editor” and “Libraries”. They are organized in a default 
arrangement.

Window Handling

The sub windows can be extracted from the main window by double clicking 
their title bar. The window then appears on top of the main window and can 
be handled as a normal window: It has its own icon in the task bar, it can be 
displaced, extended, minimized and closed. 
An extracted window disappears from the main window and the free space 
is used by the remaining windows. When an extracted window is closed it is 
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placed back into its previous location in the main window. Windows can be 
opened or closed by menu selection from the “Window” menu.
By dragging the separators between the sub windows you can change the 
height and width of the windows.

Tip: It is possible to hide both the animation editing and animation playback 
windows by choosing Window->Hide animation editing and Windows->Hide 
animation playback.  This creates significantly more screen space during 
modeling. 

Main Menu

The main menu is located in the top section of the main window. It provides 
the topics “File”, “Edit”, “Special”, “Window” and “Help”. To make selections 
from the main menu you can also use key shortcuts. All functions that are 
often used are also available with a shortcut which is shown behind the 
name of the menu item. 

File Menu

• New
Clears the main window and allows to create a new model.

• Open
Opens a dialog box that allows you to select a file you want to open in 
Xfrog.

• Insert Item
Opens a dialog box to specify a component or component hierarchy to be 
inserted into the current model.

• Save
Saves the changes made to the current file. 

• Save As
Opens a dialog box that allows you to specify a name and a location for 
the current file and save it.
• Save Image
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Allows to save the image that is currently visible in the model view. 
The file format for this image is specified in a submenu offering the PNG-
format and the JPG-format.

• Save Image Sequence (Xfrog Full only)
Allows to save all frames of the animation sequence as single images.  
The file format for these images is specified in a submenu offering the 
PNG-format and the JPG-format.

• Save Item
Allows to save either only the selected component or the entire sub-
hierarchy of components linked under the selected component. 
A submenu offers the corresponding choice.

• Export
Allows to export the Xfrog model in a file format used by other 3d packages.
The “Export” command provides the following file formats in a submenu:
RayShade (.shade), Wavefront (.obj), Autocad (.dxf), Renderman (.rib) and 
VRML 1.0 (.wrl). Components that are hidden are not exported.

Tip: 
All renderman.rib files are handled as archives and do not contain 
information about camera settings etc. In case a “Re-Use” link is used in the 
model the export will create a nested archive structure where the main file 
contains a reference to another archive. These files are written to a directory 
named as the model plus the extension “archive”. 
Colors and textures assigned in Xfrog are written into the .rib file and 
identified with the names specified in the “Material” tab. If no name is 
specified they are named with the name of the corresponding component. 
Example: Surface: “Materialname” texturename:”texturename”

• Export Sequence (Xfrog Full only)
Allows to export all frames of the animation sequence as single files. A 
submenu offers a choice of different file formats (see above).

• Quit
Quits the application. If the model needs to be saved, Xfrog will prompt the 
user, and allow changes to be saved.       
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Edit Menu

The Edit Menu is also available on right mouse button click as a context 
menu in the “Hierarchy Editor”.

• Undo
Undo the last action. You can Undo up to 6 actions.

• Redo
When an action has an “Undo” it can be applied again with “Redo”.

• New Component
Creates a new component in the “Hierarchy Editor”. The component to be 
created is selected from a submenu.

• Copy Component
Copies the selected component. The copy appears in the “Hierarchy Editor” 
next to the current hierarchy and can be dragged to link it to the hierarchy.
The “Copy Component” command has the same functionality as the “Copy” 
button in the bottom of the “Hierarchy Editor” window.

• Copy Component And Children
Copies the selected component and all subsequent components linked to it. 
The copy appears in the “Hierarchy Editor” next to the current hierarchy and 
can be dragged to link it to the hierarchy.
The “Copy Component And Children” command has the same functionality 
as the “CopyAll” button in the bottom of the “Hierarchy Editor” window.

• Hide
Hides the selected component and all subsequent components linked to it. 
The icon in the “Hierarchy Editor” is greyed out and the geometry generated 
by the hidden components is not displayed in the “Model View”. When 
a component is hidden the menu item turns into “UnHide” and allows to 
display the component again when selected a second time.
The “Hide” command has the same functionality as the “Hide” button in the 
bottom of the “Hierarchy Editor” window. Components that are hidden in the 
“Hierarchy Editor” are also removed from the model exported with one of the 
“Export” or “Export Sequence” functions.
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• Group
Combines the selected component and all subsequent components linked 
to it in a group. The group is displayed as a single icon and thus allows 
you to maintain the overview over complex models and easily relink entire 
sub hierarchies.
When a sub hierarchy is grouped the menu item turns into “UnGroup” and 
allows to revert the combination and display all components of the group.
The “Group” command has the same functionality as the “Group” button in 
the bottom of the “Hierarchy Editor” window.

• Delete Component
Deletes the selected component. When the selected component is inside a 
hierarchy the sub hierarchy linked to it appears next to the current hierarchy 
and can be re linked to the hierarchy.
Components can also be deleted by pressing the “Delete” key.
The “Delete Component” command has the same functionality as the 
“Delete” button in the bottom of the “Hierarchy Editor” window.

• Set Primitive On Component
Assigns a primitive to the selected component. The primitive to be assigned 
is selected from a submenu.

• Set Link Type
Specifies the link that connects two components. To set the link type you 
have to select the link between two components. A selected link is displayed 
by a bold line. The link type to be applied is selected from a submenu.
The “Set Link Type” command has the same functionality as the “Link” pull 
down menu in the bottom of the “Hierarchy Editor” window.

• Re-Use Link
When a link is selected the re-use function can be switched on or off. When 
the re-use function is switched on every instance of the geometry generated 
by a component that is iterated by a multiplier component has the same 
parameters. This reduces the polygon count and calculation time. Switching 
the re-use function off allows the instances to have different parameters. 
A more profound explanation of this link type can be found in the section 
“Link Types”. The “Re-Use Link” command has the same functionality as the 
“ReUse” check box in the bottom of the “Hierarchy Editor” window.
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Special Menu

• Reload Textures
Reloads all textures assigned to the current model. In this way you can 
make changes made to the texture files become visible in Xfrog.

Window Menu

• Show/Hide Hierarchy Editor
Opens or closes the “Hierarchy Editor” window.

• Show/Hide Libraries
Opens or closes the “Libraries” window.

• Show/Hide Model View
Opens or closes the “Model View” window.

• Show/Hide Animation Editor
Opens or closes the “Animation  Editor” window.

• Show/Hide Animation Controls
Opens or closes the “Animation Control” window.

• Show/Hide Parameter Editor
Opens or closes the “Parameter Editor” window.

 

Help Menu

• About
Shows information on the Xfrog version you are using.

• Registration (Purchase Xfrog)
Opens a dialogbox to buy a new Xfrog license online or to change an 
existing license.
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• Visit Greenworks Website
Opens your browser and brings you automatically to the greenworks web-
site. You will find information on the latest Xfrog version, tutorials, and lots of 
examples on the greenworks website. You may find it helpful for your work 
to regularly check our website. 

• Visit Greenworks Online Store
Opens your browser and brings you directly to the greenworks online store 
offering all greenworks products for online purchase. 

• Visit Xfrog YahooGroups™ Community
Opens your browser and brings you to the Xfrog user group offering a lot of 
tips & tricks, images and advise from knowledgable Xfrog users. 

• Download Reference Manual
Opens your browser and brings you to the download page of the Xfrog 
Reference manual.

• Download Tutorial
Opens your browser and brings you to the download page of the Xfrog 
tutorial.

Status Bar

• Polys-reduction-slider

At the bottom of the “Main Window” you will find the “Status Bar”. It provides 
the “Polys”-reduction-slider which specifies the amount of polygons that will 
to be displayed. The polygon reduction has an effect on the points (Tube 
and Area) or resolution (Square, Circle, Cube, Sphere, Torus, Cylinder 
and Cone) parameter of all primitives that provide these parameters. The 
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Attractor, Triangle-Up and Triangle-Down primitives do not provide these 
parameters. 

                
Area primitive with high resolution       Area primitive with reduced resolution

Additionally to the primitive resolution it is also possible to influence the 
amount of segments that are produced by the Tree and the Leaf component 
with the poly-reduction-slider.

                                   
Tree component with high resolution       Tree component with low resolution

In the case of the Horn component it is possible to influence the resolution 
of the primitive but not the amount of segments.

   
Horn with high resolution  Horn with low resolution
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The maximum amount of polygons that is produced is defined in the 
points/resolution parameter of the different components your model consists 
of. The “Polys”-slider set to the maximum will exactly produce the amount of 
polygons specified in the components settings. Setting the slider to a lower 
value will decrease the amount of polygons that is used in the calculation 
of the model. To regain the maximum polygon amount just set the polys-
reduction-slider back to the maximum value. 
This setting has no influence on the actual parameters of the model, but is 
just a temporary change. Saving the model as an Xfrog-file will preserve the 
maximum resolution specified in the components. Exporting a model (e.g. 
as an obj-file) will export the reduced amount of polygons. 
The polys-reduction-slider allows a significant speed up of display-times 
because it reduces the amount of polygons while editing a model.It also 
allows to easily create versions of a model with different resolutions.
Next to the slider the amount of polygons in your model is displayed 
numerically.
The amount of polygons is divided into the number of polygons being 
generated and the number of polygons being displayed. The two values can 
be different, for example when the “ReUse” links are used in the model.

Tip;
The setting of the polys-reduction-slider will remain the same when opening 
a new model. 

• Messages
The “Status Bar” also displays system messages indicating what the system 
is currently doing (e.g. reading in a file).
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Hierarchy Editor

The “Hierarchy Editor” is the place where you create the structure of your 
model. The structure is set up by linking different components to the model 
hierarchy.

Title bar
The title bar of the “Hierarchy Editor” displays its name and allows to extract 
the editor from the main window.
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Show Components radio button
Displays the icons of the different components in the “Hierarchy Editor”.

Show Primitives radio button
Displays the icons of the primitives that are assigned to the components in 
the “Hierarchy Editor” window.

Editing Space
In the “Editing Space” the actual model hierarchy is built by creating and 
linking components. The “Editing Space” provides scroll bars view large 
hierarchies.

Link pull down menu
Allows to change the type of link connecting two components. Every 
component that is linked to the hierarchy will use the link type specified 
in the pull down menu. If this link type is not available with the current 
components the default link type of the parent component will be applied. 
The default link type of the Link pull down menu is multiple.
The “Link” pull down menu has the same functionality as the “Set Link Type” 
command in the “Edit” menu.
For an exhaustive explanation of link types please refer to page 23 of this 
manual.

ReUse check box
Switches the re-use function of the selected link on and off. 
The “ReUse” check box has the same functionality as the “Re-Use Link” 
command in the “Edit” menu.
For an exhaustive explanation of link types refer to the corresponding 
section.

Copy button
Copies the selected component.
The “Copy” button has the same functionality as the “Copy Component” 
command in the “Edit” menu.

CopyAll button
Copies the selected component and all subsequent components.
The “CopyAll” button has the same functionality as the “Copy Component 
And Children” command in the “Edit” menu.
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Hide button
Hides the selected component and all subsequent components.
The “Hide” button has the same functionality as the “Hide” command in the 
“Edit” menu.
Components that are hidden in the “Hierarchy Editor” are also removed 
from the model exported with one of the “Export” or “Export Sequence” 
functions.

Group button
Combines the selected component and all subsequent components in a 
group.
The “Group” button has the same functionality as the “Group” command in 
the “Edit” menu.

Delete button
Deletes the selected component. Components can also be deleted by 
pressing the “Delete” key.
The “Delete” button has the same functionality as the “Delete Component” 
command in the “Edit” menu.
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Camera

When you start Xfrog you always find the “Camera” icon called “Root” in the 
“Hierarchy Editor”. This is the origin of the hierarchy that is displayed in the 
model view. Every component that is linked to the “Root” component will be 
displayed in the “Model View” window while components that are not linked 
to the “Root” component are not displayed.
Similar to the components the “Camera” has a set of specific parameters. 
The parameters specified in this tab of the “Parameter Editor” can be 
recalled by selecting “Model View > Camera > Reset View”.

Name
Indicates the name of the “Camera”. By default the name is “Root”. You can 
change the name in the text field.

Zoom
Provides a slider to specify the focal length of the “Camera”.

Shift Horizontal
Provides a slider to shift the perspective horizontally. This kind of shifting is 
comparable to shift lenses used in photography as it preserves a rectilinear 
perspective.

Shift Vertical
Provides a slider to shift the perspective vertically. 
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Ratio
Provides a slider to specify the ratio of the horizontal scale to the vertical 
scale of the view.

Creating components

Xfrog provides nine different components. They are all available in the 
“Components” tab of the “Libraries” window. To create a new component in 
the “Hierarchy Editor” window you have several possibilities:

• Drag a component from the “Components” tab of the “Libraries” window 
and drop it into the “Hierarchy Editor”.

• Double click a component in the “Components” tab of the “Libraries” 
window and it will automatically appear in the “Hierarchy Editor”. When 
a component was selected in the “Hierarchy Editor” the new component 
will be linked to it, when no component was selected the new component 
appears next to the current hierarchy.

• Select “Edit > New Component > the component to be created” and the 
new component will appear either linked or next to the current hierarchy.

• Click the right mouse button in the “Hierarchy Editor”, select “New 
Component > the component to be created” and the new component will 
appear either linked or next to the current hierarchy.

Linking Components

All models in Xfrog are created by linking components together and thus 
setting up the model hierarchy. Normally the beginning of a model hierarchy 
is the “Camera” icon called “Root”. Components linked to the “Camera” are 
visible in the “Model View” window.
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To make Components link together, you drag one component onto a second 
component. The dragged component will be linked as a successor (child) of 
the component you dragged it onto (parent). 

When you drag a component from the “Components” tab of the “Libraries” 
window onto a component in the “Hierarchy Editor”, a new component is 
created and linked to the existing hierarchy.
When you create a new component by menu selection, it is always linked 
to the selected component in the “Hierarchy Editor”. When no component is 
selected, the new component appears next to the current hierarchy.
As the “Root” component is automatically selected after launching Xfrog, 
you just have to double click one of the components in the “Components” 
tab in the “Libraries” window to create a new component and, link it to the 
“Root” component.

One component can be the parent of several subsequent components.
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Components and their subsequent hierarchies can be disconnected from a 
hierarchy by dragging them away from it. The disconnected parts appear 
next to the hierarchy.
Entire sub hierarchies can be connected to a hierarchy by dragging the first 
component of the sub hierarchy onto the component it should be linked to.

Tip:
This allows you for example to connect only a part of your model hierarchy 
to the camera to edit this part isolated from the rest and then integrate it 
into your model hierarchy. In this way you can speed up the calculation time 
when you are working with a complex model.

Instancing Components

Components can be instanced to use the same geometry in different parts 
of the model hierarchy. This is done by holding down the shift key and 
dragging one component in the model hierarchy onto another component in 
the same hierarchy. A second component bearing the same name is created 
and, linked to the component it was dragged on. The two components and 
every further instance of them share the same set of parameters and, thus 
are completely indentical.This means that changes made to the parameters 
of one of these components will affect all of the corresponding instances.
Instances always have to be linked to the model hierarchy. Disconnecting 
one of the instances will delete the component until only one component 
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is left. The last component behaves as a normal component and can be 
disconnected, deleted etc. like normal.

                          
One ‘normal’ “Revo” component is linked to the third tree component. 

The “Revo” component is instanced and linked to the other tree components 
which iterate the same geometry as the previous one. 
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Link Types

The model hierarchy is set by linking components together. Thus the 
structure of a model is determined by which components are connected 
and how they are connected. The link type specifies the way in which 
components are connected. There are two different link types in Xfrog, the 
“Simple” link and the “Multiple” link. 
Each of the different components in Xfrog provides structural information on 
how to place geometry in space. Every component generates one or more 
origins where this geometry is created. For example, a “Simple” component 
generates only one origin and a ”Tree” component creates several of them 
used to multiply branches. In every origin it is possible either to create 
geometry (primitives) or to connect a new component. 

Connecting one component to a second with a simple link will connect 
the new component to the last origin that is generated by the previous 
component. This means when you connect one “Horn” to a second the new 
component will be created on top of the first one. 
Connecting the two components with a “Multiple” link will create the new 
component in every origin generated by the first component. In the “Horn” 
example the second “Horn” will be connected to the first like ribs

          
 Simple link     Multiple link

The choice between “Simple” and “Multiple” link is not available with every 
component. The “Simple” component provides only the simple link and there 
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are others, like the “PhiBall” component, that only provide the “Multiple” link.
With the two basic link types it is possible to turn the re-use function on 
or off. As Xfrog models can be very complex – just imagine a big tree with 
thousands of branches and leafs – we introduced the re-use function. When 
you use a multiplier component such as the “Horn” in our previous example, 
you may create a high number of subsequent components (the ribs). 
With the re-use function turned on, only one rib is calculated and then 
copied to the other origins. In this case all ribs look exactly the same. 
Turning the re-use function on allows you to drastically reduce the amount of 
polygons in your model and, to speed up calculation time.
In some cases it is desirable that the multiplied instances look different. 
In a tree model you want all branches to look different, you want to scale 
them according to their location on the trunk etc. In this case it is necessary 
to turn the re-use function off and allow every instance to have its own 
parameters. 

         
Re-Use function turned on      Re-Use function turned off

Tip:
Also when you want to use the random function (rnd) of a multiplied “Horn” 
component you have to turn the re-use function off. Otherwise all horns look 
the same and no randomness is visible.
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Libraries Window

The “Libraries” window gives access to all constructive elements in Xfrog. 
It provides two tabs: the “Components” tab and the “Primitives” tab. By 
switching between these tabs you have either direct access to all available 
components or to all available primitives.
To create a new component, drag the component from the “Libraries” 
window into the “Hierarchy Editor”. To assign a new primitive to a 
component, drag the primitive from the “Libraries” window onto the 
component. 

Xfrog provides on one hand the normal geometrical primitives such as cube, 
sphere etc. and, on the other hand it provides components that define how 
the geometry is structured in space. All geometry is bound to components. 
This means that when you want to create just a single sphere you first have 
to define how the sphere is organized in space. You do this by linking a 
component to your model hierarchy and then assigning the desired primitive 
to the component. The sphere for example is made by creating a “Simple” 
component and assigning the “Sphere” primitive to it.

         
   Components Library        Primitives Library
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Model View Window

In the center of the interface you find the “Model View” window. This is the 
window where the graphical output of Xfrog is displayed and where you 
can view your model. 

Navigation

You have the following possibilities for interactive navigation in the “Model 
View”.

Rotation
Hold down the left mouse button and drag to rotate the view. The center of 
the rotation is the origin of the global coordinate system.
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Shift
Hold down the right mouse button and drag to shift the view sideways. 

Dolly
Hold down both mouse button and drag to dolly in and out. 

Menu Bar

The menu located in the upper part of the “Model View” window provides 
functions to control how your model is displayed in the “Model View” window. 
It provides the topics “Shading”, “Display”, “Background” and “Camera”.

Shading Menu

• Wireframe
Displays the triangle mesh of your model as a wireframe. The wireframe can 
be combined with a shaded display.

• Shading
Displays your model flat shaded. 
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• Gouraud
Displays your model with smooth shading.

Display Menu

• Show/Hide Vertices
Switches the display of the vertex points of all primitives on and off. The 
vertex points are the corner points of the triangles your model consists of.
• Show/Hide Vertices
Switches the display of the normals of all surfaces in your model on and 
off. The normals are vectors defining which direction the surface will reflect 
light. 

• Show/Hide Local Axis
Switches the display of the axis of the local coordinate system of all objects 
in your model on and off. Every component has its individual coordinate 
system which is relative to the orientation of the component in the global 
coordinate system.

• Show/Hide World Axis
Switches the display of the axis of the global coordinate system on and off.

• Show/Hide Splines
Switches the display of the of the vector along which point list primitives 
are multiplied on and off.

• Show/Hide Attractors
Switches the display of all “Attractor” primitives in your model on and off.

• Show/Hide Textures
Switches the display of all textures used in your model on and off.
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Background 

• Edit Background Color
Opens a color editor window to specify the background color of the “Model 
View” window.

Camera

• Store View
Saves the current view.

• Recall View
Recalls a previously saved view.

• Reset View
Resets the view to the parameters specified in the “Camera”.

• Fit To Window
Dollies the view so that the entire model is displayed in the “Model View” 
window.

• Lock X Axis
Constrains the rotation to the X Axis. This can be useful to prevent 
unintentional changes of the interactive camera in other directions than the 
desired one. The locking function works as a toggle switch.

• Lock Y Axis
Constrains the rotation to the Y Axis. The locking function works as a toggle 
switch.

• Lock Z Axis
Constrains the rotation to the Z Axis. The locking function works as a toggle 
switch.
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Parameter Editor Window

The “Parameter Editor” window gives access to all parameters of the 
different components. It is context sensitive and displays always the 
parameters of the selected component. If no component is selected the 
window is empty. 
Normally the “Parameter Editor” provides four tabs except for the “Simple” 
component and the “Camera”). The first one is named according to the 
selected component type and contains all parameters that are specific to 
this component. 
The second to fourth tabs are common to all components. The second tab 
is called “Basic” and contains basic parameters such as placement in 3D 
space etc. 
The third tab is called “Primitive” and contains all parameters concerning the 
primitive assigned to the component. 
The fourth tab is called “Material” and contains all parameters concerning 
color and texture assigned to the component.
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Controls

The “Parameter Editor” window provides several different controls to specify 
values. 

Text fields

Text fields are used to type in text or numbers. Place the cursor in a text field 
and it changes to a text cursor. Type in the value and press the return key to 
confirm the settings. If not confirmed the settings are not applied.

Sliders

Sliders are used to specify a numeric value. The value can either be set 
by clicking into the slider field and dragging or by typing them into the text 
field left from the slider field. The range of the slider is indicated by the  two 
numbers above the slider ends. It can be changed by double clicking one 
of the numbers. The number turns into a text field allowing you to type in 
the new value. Pressing the return key confirms the settings and removes 
the text field.

Double sliders

Double slider are used to specify a range value. They are used with 
multiplier components and allow to successively change the multiplied 
instances. If for example you want to multiply several boxes with decreasing 
size you use define a scaling factor for the first box with the upper slider and 
a scaling factor for the last box. The intermediate values are interpolated 
and produce an evenly decreasing size of your boxes. 
You can also assign a mathematical function that is used to calculate the 
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intermediate values. The function can be selected from the pull down menu 
left from the double slider. The menu offers a number of predefined functions 
and, also allows you to specify your own functions by selecting “custom...” 
from the menu. 

The following images show some examples of common mathematical 
functions assigned to the “Shape” definition of a “Horn” component. The 
range goes from -3.142 to 3.142.

                 

“id”: returns the 
identical value (y=x)         

“sin”: returns the sinus  
value (y=sin x)       

“cos”: returns the 
cosinus value 
(y=cos x)

                  

“atan”: returns the 
atangens value 
(y=atan x)   

“rnd”: returns a random 
value (y=rnd x)        

“sqr”: returns the 
squared value (y=x2)
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Pull Down Menus

Pull down menus are used to select from a choice of predefined 
possibilities. Click the menu field to make a list of available options appear. 
Select the desired option.

Radio Buttons

Radio buttons are used to exclusively switch between several options. Click 
the corresponding button to turn the desired option on and all others off.  

Graph Editors

Graph editors are used to specify values depending on two variables. They 
are only used in the “Tree” component where it is necessary to specify a 
certain value for a specific location. 
The X-axis of the graph editor is referring to the length of a branch or trunk 
and the Y-axis is referring to the value that is specified. The settings are 
changed by dragging the points defining the graph.
The graph editor in the “Parameter Editor” window is only for rough editing. 
Clicking the “Edit” button left from the graph editor open a separate window 
where the graph can be edited more precisely. 
Here you can select one or more points by clicking (for multiple selection 
shift-clicking) them and move them around by dragging them.
You can add points to the graph by double clicking at the location where 
you want to insert a point. 
Points are deleted by selecting them and pressing the backspace key.
To deselect points click somewhere in the window.
You can also insert points and remove points by adjusting the “Resolution” 
slider at the bottom of the window.
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v

Tip:
As the X-axis always refers to the full length of a branch it may happen that, 
when the branch is scaled down, you change the graph and no changes 
are visible in the “Model View” window. In this case the graph is referring 
to a part of the branch that is not produced because the branch is scaled 
to a smaller size.
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  Spline Editor

Some components like the “Tree” component provide spline editors for 
certain parameters. The curvature of a tree’s trunc can be defined by a 
spline. Toggling the “Spline” option in the “Tree” component’s parameters to 
“on” brings up a button called “Points”. Clicking this button opens the spline 
editor window. 

    
The navigation inside the “Spline Editor” is the same like in the “Model View” 
window: Left mouse-button for rotation, right mouse-button for translation 
and both mouse-buttons for zooming. 
The editing process of the spline is the almost same as in the “Graph 
Editor”: Points can be selected by clicking them and moved by dragging the 
selected point. It is possible to select several points at a time by shift-clicking 
them. New points can be added by double-clicking onto the spline. Points 
can be deleted by selecting the point(s) to be deleted and then pressing 
the backspace-button. 
In the bottom area of the Spline Editor window are three button labeled 
“View X”, “View Y” and “View Z” which allow to constrain the view to the 
corresponding axis.
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Material Parameters

The “Material” tab contains all parameters concerning color and texture. 
Colors and textures can either be inherited from the parent component 
or they can be assigned explicitly for a component. By default colors and 
textures are inherited and passed through the whole hierarchy. This is done 
as long as no other color or texture is defined in a subsequent component. 

Name
Indicates the name of the selected component. The name can be changed 
in the text field.

Color
Provides two radio buttons to switch between color inheritance and local 
color definition. If “Color” is set to “inherited”, the component will use the 
color definition made in one of the parent components.
If “Color” is set to “set”, several controls to define the color are displayed.
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Name
Provides a text field where you can specify a name for the color. This is 
useful when you export your model in order to recognize the color and 
indicate shaders after importing it into other modeling software. 

Alpha
Provides a slider to specify the degree of transparency of the component. 
The limits of the slider are fixed to the range from 0 to 1.

Diffuse
Allows to specify a color for the diffuse part of the light reflected by the 
component. The color is shown in a preview field. Left from the preview field 
is an “Edit” button that opens a color editor to specify the color.

Ambient
Allows to specify a color for the ambient light that illuminates the 
component. The color is shown in a preview field. Left from the preview field 
is an “Edit” button that opens a color editor to specify the color.

Specular
Allows to specify a color for the part of the light reflected by the highlights of 
the component. The color is shown in a preview field. Left from the preview 
field is an “Edit” button that opens a color editor to specify the color.

Emission
Allows to specify a color for the light emitted by the component. The color is 
shown in a preview field. Left from the preview field is an “Edit” button that 
opens a color editor to specify the color.

Texture
Provides two radio buttons to switch between texture inheritance and local 
texture definition. If “Texture” is set to “inherited”, the component will use the 
texture defined in one of the parent components.
If “Texture” is set to “set”, several controls to assign and control the texture 
for the component are displayed.

Name
Provides a text field where you can specify a name for the texture. This is 
useful when you export your model in order to recognize the texture after 
importing it into other modeling software. 
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FileName
Provides a text field to specify the name of the image file you want to assign 
as a texture to the selected component. Clicking the “Browse” button left 
from the text field opens a dialog box where you can select the image file 
to be assigned. Xfrog supports PNG files and RGB files that can contain 
alpha channels.

Shift U
Provides a slider to specify a value to shift the texture in direction of the 
U-axis. Textures have an individual coordinate system with the U-axis and 
the V-axis referring to the flat image. This allows to easily displace textures 
independently from the coordinate system of the model. 

Shift V
Provides a slider to specify a value to shift the texture in direction of the 
V-axis. 

Scale U
Provides a slider to specify a value to scale the texture in direction of the 
U-axis.

Scale V
Provides a slider to specify a value to scale the texture in direction of the 
V-axis.

Mapping
Provides a pull down menu to specify the way in which the texture is applied 
to the model. In “none” mode the texture is mapped onto the surface of the 
object and scaled so that it fits exactly on the surface. 
In “linear” mode the texture is repeated on the object’s surface as often as it 
fits onto it. The texture is not scaled.
In “reflection” mode the texture is projected onto the object’s surface and 
scaled to fit onto it. In this mode the texture stays fixed to the environment 
of the object and is reflected by the object as if it had a mirroring surface. 
When the object is turned in space the texture does not turn with it but 
remains in it’s initial position. 
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Color Editor

Clicking the “Edit” button in the “Material > Color” section opens the “Color 
Editor”. The editor provides several controls to define a color.

Clicking into the rainbow color field or into one of the fields containing plain 
color allows to select a color. The brightness of the selected color can be 
adjusted with the gradient slider at the right side of the editor window. The 
selected color is displayed in the preview field at the bottom of the editor 
window. 
You can also specify a color by typing either the RGB values or the HSB 
values into the fields below the  rainbow color field. 
The color that is visible in the preview field can be added to the list of 
custom colors by clicking the “Add To Custom Colors” button.
Clicking the “OK” button assigns the color to your model.  
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Animation Editor Window
(This chapter only concerns the Full version of Xfrog)

The “Animation Editor” window is the place where you add life to your Xfrog 
models. It is possible to animate nearly every parameter of Xfrog models. 
The only properties that cannot be animated are material parameters such 
as colors and textures.
The “Animation Editor” window and the “Animation Control” window are 
tightly connected as the “Animation Control” window provides all the controls 
to edit and view the animation sequence that is build in the “Animation 
Editor” window. 

The “Animation Editor” consists of the timeline and the animation track. The 
timeline provides a timeslider (the little black triangle) that can be moved 
back and forth to view the animation and to access different times. The 
animation track contains the keyframes of the animation. 

    The timeslider

The timeline ranges between 0 and 1. This timeframe can be subdivided into 
a variable amount of frames. By default the amount is set to 100 frames. 
To speed up the animation you have to specify a smaller amount whereas 
a higher amount will slow it down. The amount of frames is set in the 
“Animation Control” window which is described below. 
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The amount of frames also influences the number of images or models that 
are exported when you select one of the “Export Sequence” functions in 
the “File Menu”. A value of 100 frames will produce 100 images or models, 
while a value of e.g. 50 frames will produce 50 images/models throughout 
the animation sequence. In both cases the whole animation sequence is 
exported but with bigger or smaller intervals. The timeline indicates the 
frames with tickmarks. 
The limits of the animation sequence can be changed by moving the start- 
and end-marks of the timeline. Thus it is possible e.g. to export only a part 
of the entire sequence. 

   
Start-mark of the sequence  End-mark of the sequence

Left from the animation track are two check-boxes called “Edit” and “Cam”. 
Checking the “Edit” option makes the track editable, unchecking it prevents 
editing. 
Checking the “Cam” option displays the camera positions that have been 
keyed, unchecking it, switches to the interactive camera display (for a 
detailed description see below).

  
The “Edit” and “Cam” check-boxes

Working with Keyframes

The timeline initially provides two keyframes, the keyframe of time 0 and the 
keyframe of time 1. The model hierarchy is the same in all keyframes only 
the parameters of the different components can differ from one keyframe 
to the other. This means that alterations to the model hierarchy will affect 
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all keyframes and alterations to the parameters will only affect the selected 
keyframe. By default the first keyframe is selected. Keyframes are selected 
by clicking on them once. 

Tip:
A simple animation of a growing tree can be realized within only a few steps. 
You build a model hierarchy consisting of some Tree Components. 
A tree based on the default settings of the components is created. With 
the first keyframe selected simply reduce the “Trunc-Scale” parameter of 
the first Tree Component to 0. The animation will show a tree growing from 
0 to it’s full size.   

  

  



43

Xfrog 3.5 Reference Manual

Creating Keyframes

A new keyframe is created by setting the timeslider to the position where 
the new keyframe should appear and then either clicking the “New” button in 
the “Animation Control” window or by selecting “New Key” from the context 
menu of the right mouse-button.
A second way to create new keyframes is to double-click the animation-track 
at the location where the keyframe should appear. 

Changing the time of a keyframe

The position of a keyframe on the animation-track signifies the time in the 
animation when the parameter constellation stored in that key is generated. 
The time can be changed by dragging the keyframe to another position.

Copying Keyframes

A keyframe can be copied by selecting the key and then clicking the “Cpy” 
button in the “Animation Controls” window or by selecting “Copy Key” from 
the context menu of the right mouse-button. 

Deleting Keyframes

A keyframe can be deleted by selecting the key and then either pressing 
the backspace key, or clicking the “Del” button in the “Animation Control” 
window or by selecting “Delete Key” from the context menu of the right 
mouse-button.

Keying the camera position

It is possible to animate the camera by storing the position of the interactive 
camera to a keyframe. To set a camera key you have to select a keyframe 
and then move the interactive camera into the desired position. Hit the 
“Cam” button of the “Animation Control” window or select “Store Camera At 
Key” from the context menu of the right mouse-button to save the position.
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Copying parameters to keys

When a parameter of a component is changed, this change only has 
effect on the selected key. For global changes it is possible to copy a 
parameter into all keyframes of the animation sequence. Every parameter 
in the “Parameter Editor” window has a little cross next to the name of the 
parameter. Clicking this cross brings up a menu with the option “Copy To 
All Keyframes” which copies the currently set parameter into all keyframes 
of the animation sequence. 

   The “Copy To All Keyframes” option
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Using functions in Animation

In parameters that are defined by a range-definition as in the Horn or Leaf 
component (see “Double Slider” in the “Controls” section of the “Parameter 
Editor” chapter) it is possible to apply functions. One of the possible 
functions is “ftime”. It refers to the animation-time and uses it to calculate the 
actual value of the parameter. As the animation time is normalized between 
0 and 1 it is easy to use it in calculations. 
The following example shows how the “ftime” function can be used. It 
consists of a Horn component connected to the camera and the two default 
keyframes. In the Curvature definition of the Horn the “ftime” function is 
applied to the “Rotation Y” and to the “Rotation Z” parameter. 

  Using the “ftime” function

The scope of functions assigned to parameters is global throughout the 
whole animation sequence whereas the parameter values themselves are 
only locally defined for a specific keyframe. This means that in our example 
the “ftime” function is valid for the whole sequence. 
The “ftime” function returns the time value of the current frame and this 
value is used to calculate the Horn’s rotation. In the first frame the frame 
time is 0 so no rotation is generated and the Horn is straight. While the 
animation moves on, the frame-time increases and the Horn starts bending 
slowly. At the end of the animation the rotation increment will be 1 and the 
Horn reaches it’s maximum bending. As the “ftime” function is applied to the 
Y and the Z rotation the Horn will describe a screw-like curve. 
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A screw-curve narrowing down over time produced with the “ftime” function
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Animation Control Window
(This chapter only concerns the Full version of Xfrog)

The “Animation Control” window provides all means that are necessary to 
control animation like playing the animation, setting keyframes, determining 
the speed etc.

Keyframe Section

New button
Creates a new keyframe at the current position of the timeslider.
(See also “Working with keyframes” in the “Animation Editor” chapter).

Cpy button
Duplicates the selected keyframe.
(See also “Working with keyframes” in the “Animation Editor” chapter).

Del button
Deletes the selected keyframe.
(See also “Working with keyframes” in the “Animation Editor” chapter).

Cam button
Stores the position of the interactive camera in the currently selected 
keyframe. (See also “Working with keyframes” in the “Animation Editor” 
chapter).
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Playback Section

Rewind button
Moves the timeslider to the beginning of the animation sequence.

Step-back button
Moves the timeslider one frame back.

Play-reverse button
Plays the animation in reversed order.

Play button
Plays the animation.

Step-forward button
Moves the timeslider one frame forward.

Fast-forward button
Moves the timeslider to the end of the aniamtion sequence.
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Time Section

Frm field
Displays the number of the frame at the current position of the timeslider. 
Typing a number into this field moves the timeslider to the corresponding 
position.

Frms field
Displays the amount of frames the animation sequence contains. The 
amount of frames determines the speed of the animation. The higher the 
value the slower and smoother the animation is. This value also determines 
the number of images or models that are exported when choosing the 
“Export Sequence” command (see also the chapter “Animation Editor 
Window”).

Loop pull-down menu
Determines if the animation is played back in a continuous loop which 
starts always at the beginning of the animation and plays to the end; if the 
animation swings continuously back and forth from the beginning to the end 
and from the end to the beginning; or if the animation is played only once 
from the beginning to the end. 

Time field
Displays the time value of the current position of the timeslider. Typing a 
number into this field moves the timeslider to the corresponding position. 
The time value will always be a number between 0 and 1.
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Components
Nine different components are available in Xfrog. They are divided into 
components with the main purpose to create geometry, components with 
the main purpose to multiply geometry and components that deform 
geometry. Each component has a set of parameters that are specific to its 
purpose and besides that, all components have parameters like location in 
3D space etc. in common. The components that are mainly used to create 
geometry have already a primitive assigned to them, while the multiplier 
components come without primitive. When components are linked together 
in a hierarchy certain parameters are passed on from one component to its 
subsequent components (the parameters are inherited).

Basic Parameters

All components provide the set of “Basic” parameters. These parameters 
define the location and orientation of the component in 3D space. 
The “Basic” parameters are available in the “Basic” tab of the “Parameter 
Editor” window.
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Name
Indicates the name of the selected component. The name is editable in 
the Text field.

Transformation > Translation
The “Translation” section provides three sliders that allow a translation of the 
selected component along the X-axis, Y-axis and the Z-axis. 

Transformation > Rotation
The “Rotation” section provides three sliders that allow a rotation of the 
selected component around the X-axis, Y-axis and the Z-axis. 
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Transformation > Scale
The “Scale” section provides three sliders that allow scaling of the selected 
component in direction of the X-axis, direction of the Y-axis and direction 
of the Z-axis. 

When the radio button “Lock Scale” is set to “Off” the scaling can be done 
in each direction separately, if the button is set to “Off” the scaling is done 
proportionally in all directions.

Phototropism
Applying “Phototropism” allows to give your component a global orientation 
in a certain direction. This is especially useful to simulate a tree’s orientation 
towards the sun.
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The “Phototropism” section provides the “Direction” pull down menu to 
specify the direction of the orientation and the “Strength” slider to specify 
its strength.

Tip:
If you want to specify an orientation in X- and Y-direction at the same time 
you have to insert a “Simple” component in the hierarchy before your current 
component and then assign the X-direction in the “Simple” component and 
the Y-direction in your current component.

Simple Component

The “Simple” component is used to create only one instance of a primitive. 
When the component is created it has no default primitive assigned, so 
there is nothing visible in the model view. To make something appear in 
the model view, you have to specify the geometry that should be created 
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by the component by assigning a primitive to it. The “Simple” component 
can receive any primitive available in Xfrog. As the two primitives “Tube” 
and “Area” are point lists to be triangulated with a second point list, they do 
not deliver a useful result when assigned to the “Simple” component. The 
“Simple” component creates just one instance of the assigned primitive thus 
no second point list and no visible geometry are created. 
In the image below a cube is assigned to the “Simple” component.

“Simple” component with a cube primitive

The “Simple” component has only the “Basic” parameters available in the 
“Basic” tab of the “Parameter Editor”. 
Besides the “Basic” parameters it also provides the “Primitive” tab and the 
“Material” tab in the “Parameter Editor” window.
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Horn Component

The “Horn” component is one of the components that already have a default 
primitive assigned. It comes with a “Tube” primitive and generates a hornlike 
shape that can be used for twigs etc. 
The “Horn” component generates a row of origins and in each origin a 
primitive is created. In the default settings of the “Horn” the point lists of 
the “Tube” primitive are triangulated among themselves to create the hull of 
the horn and, additionally they are scaled down with a cosinus function to 
achieve the conical shape.
You can assign any primitive to the “Horn” component and this primitive will 
be multiplied along the horn (iterated).

                   
“Horn” with “Tube” primitive                    “Horn” with “Box” primitive



56

Xfrog 3.5 Reference Manual

Like all other components the “Horn” component provides the “Basic” 
tab, the “Primitive” tab and the “Material” tab in the parameters editor. 
Additionally it provides the “Horn” tab containing parameters that are 
specific to the “Horn” component.



  57

Xfrog 3.5 Reference Manual

Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.

Stem > Segments
Provides a slider to specify the amount of segments the horn consists of. 
The higher the amount the smoother the curves when the horn is bent. The 
amount of segments also defines the number of origins/primitives generated 
by the component. 

Stem > Length
Provides a slider to specify the distance on which the origins/primitives 
generated by the component are distributed. 
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Curvature 
Provides a pull down menu to specify the way in which the curvature of 
the shape is defined. The menu offers the choice between “fixed range”, 
“implicit range” and “spline”. “Implicit” and “fixed” differ in the way how an 
increased number of segments effects the length of the horn. When “Fixed” 
is turned on the overall length of the horn stays the same when the number 
of segments is raised. When “implicit” is turned on the overall length of the 
horn grows when the number of segments is raised. 
This effect is comparable to the “Length” option with the difference that 
a increased “Length” value scales the segments and thus distorts applied 
textures, whereas the increased number of segments does not distort the 
texture. If the “spline” option is turned on the curvature is defined by a spline. 
In this case an “Edit” button appears to invoke a “Spline Editor” window. 
The spline definition maintains the lentgh of the horn independent from the 
amount of segments. 

Curvature > Rotation
Provides three double-sliders to specify range values for the rotation of the 
primitives separately for the X-axis, Y-axis and the Z-axis. 
Double sliders are used to specify a range definition. The upper slider is 
used to specify the value (in this case the degree of rotation) that is applied 
to the first primitive that is generated by the component and the lower 
slider is used to specify the value that is applied to the last primitive. The 
intermediate values are interpolated 
Using the pull down menu left from the double slider, you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.
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Curvature > Translation
Provides three double-sliders to specify range values for the translation of 
the primitives separately for the X-axis, Y-axis and the Z-axis. 
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.

Shape
Provides two radio buttons to switch between an range definition of the 
horn’s shape and a spline definition. 
When “Shape” is set to “Range” the “Range” section appears providing a 
double slider to specify a range definition for the scaling of the first and 
the last primitive.
When “Shape” is set to “Spline” the outline of the horn can be drawn by 
manipulating a spline. In this case the “Points” section appears providing an 
“Edit” button to open the spline editor window.
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Range
Provides a double slider to specify a range definition for the scaling of the 
primitives generated by the component. The upper slider is used to specify 
the scaling of the first primitive and the lower slider is used to specify 
the scaling of the last primitive. The scaling values for the intermediate 
primitives are interpolated.
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition. In the default setting of the “Horn” component 
this function is set to cosinus, which creates a smooth conical shape.

Spline
Provides an “Edit” button to open the spline editor to specify the outline of 
the horns shape.
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The spline editor window provides a slider to specify the resolution of the 
spline i.e. the number of nodes that define the spline.

Top
Provides two radio buttons to specify if the horn is closed at the top or if 
it is an open tube. 

Scale
As the “Horn” component is a multiplier component it is not only possible to 
multiply primitives with a “Horn” but also subsequent components. Attaching 
a second “Horn” component to a first one and setting the link type to 
“Multiple” creates new horns in all origins generated by the first component. 
The instances of the second horn are than attached like ribs to the first 
horn. 
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The subsequent component can receive parameters from the first 
component. Thus you can use the double slider provided in the “Scale” 
section to scale the ribs of the horn. 
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.

  

Steps
By default the ribs are created in every origin created by the first “Horn” 
component. You can use the “Steps” double slider to skip some of the origins 
and create a rib e.g. only every other origin. Again a range definition is 
used to specify the amount of origins to skip before creating the first rib and 
the amount of origins to skip before creating the last rib. The intermediate 
values are interpolated. 
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.
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Screw
Provides a double slider to specify a range definition rotating the ribs around 
the first horn. A mathematical function can be applied to the rotation values.

Flap
Provides a double slider to specify a range definition to rotate the ribs 
around their longitudinal axis. 
Using the pull down menu left from the double slider you can apply a 
mathematical function to the rotation values.
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Tree Component

The “Tree” component is dedicated to create trees. Like the “Horn” it comes 
with a “Tube” primitive and generates a hornlike shape that is perfect for 
trunks. The “Tree” component also generates a row of origins and in each 
origin a primitive is created. Different from the “Horn” it does not create ribs 
when a second tree component is linked to it, but branches. 
Every “Tree” component linked to a previous one with a “Multiple” link 
creates an entire new branching level. Thus you can add a lot of branches 
to your tree by simply attaching another “Tree” component. You never have 
to deal with every branch separately but you can edit the parameters of all 
these branches on the whole by editing the parameters of the multiplying 
“Tree” component.

In order to control the shape and structure of the branches the “Tree” 
component provides a big set of parameters specific to trees. The “Tree” 
component is the most complex component in Xfrog. It introduces a lot of 
parameters derived from nature to give your trees a realistic look. You can 
add tropisms to your model to simulate lighting and gravity conditions, you 
can add a customizable irregularity to your tree as naturally grown trees 
have, you can arrange branches and leaves in a pair and impair order, make 
them grow perpendicular or lateral to the stems or branches axis etc.
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Tip:
You can also use the “Tree” component to create the roots. As the roots 
are also arranged in a branching structure you can build them by linking 
together normal “Tree” components, maybe using a spline to achieve the 
correct curvature and applying “Crookedness”. To connect the roots to your 
tree, you should use a “Simple” component as basis for your tree hierarchy 
and another “Simple” as basis for your roots hierarchy. The “Simple” of the 
roots hierarchy has to be rotated by 180 degrees and then attached to the 
“Simple” of your tree hierarchy.
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Name
Indicates the name of the selected component. The name can be changed 
in the text field.

Stem > Segments
Provides a slider to specify the amount of segments the tree consists of. 
A high amount of segments gives your tree a smooth look. If you assign 
crookedness to the stem you need a higher amount of segments in order 
to produce all the small curves. On the other hand a high amount of 
segments increases the complexity and the polygon count of your model. 
Thus you should always try to find the optimal balance between the number 
of segments and the optical result required for the purpose of your model.

Stem > Length
Provides a slider to specify the length of the stem or – if the selected 
component is attached as a branch – the length of the first branch that 
is created. In order to give your tree a naturalistic look the branches are 
sequentially scaled to match the thickness of the trunk. At the bottom of the 
trunk you will find thick and long branches, while the branches at the top of 
the tree are thin and short. The scaling parameters are depending on the 
shape you assign to the trunk and are automatically passed from the parent 
“Tree” component to it’s children. The settings you specify in the “Parameter 
Editor” always refer to the non scaled size of the branches.



  67

Xfrog 3.5 Reference Manual

When you change the length of the trunk the location of the branches is 
changed but not their size. This means a given amount of branches is 
loosely distributed along a long trunk and densely distributed along a short 
trunk.

Stem > Trunk Scale
Provides a slider to specify a global scaling factor to your tree model. 
Different from the length settings the “Trunk Scale” parameter scales the 
entire tree by keeping the branches in their initial place. The scaling factor is 
passed down to the branches and they are scaled accordingly. This can be 
used to simulate the growth of a tree. 

  

Tip:
As scaling parameters are passed to subsequent components it may 
happen that a scaling factor in the parent component is set to a value 
that the linked child component is not produced anymore. When the parent 
component passes on a scaling factor of zero the child component will 
not be visible. This is for example the case when you link a second “Tree” 
component with a “Simple” link to a first “Tree” component. 
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Stem > Spline
Provides two radio buttons to switch the definition of the curvature of the 
trunk on and off. When “Spline” is set to on, an “Edit” button appears to open 
a spline editor window.

Stem > Shape
Provides a spline editor to specify the outline of the trunk by manipulating 
a spline.

Top
Provides two radio buttons to specify if the horn is closed at the top or if 
it is an open tube. 
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Crookedness > Amount
The “Crookedness” function adds irregularities to the tree as appearing in 
naturally grown trees. This is done by adding curves to the trunk. 
The “Crookedness > Amount” section provides a slider to specify the 
amount of curves added to the trunk.

Crookedness > Intensity
Provides a graph editor to specify the intensity of the curves added to the 
trunk. The spline represents the length of the trunk. This means that the left 
part of the spline corresponds to the bottom part of the trunk and the right 
part of the spline corresponds to the top of the trunk. Thus you can specify 
the intensity of the “Crookedness” independently for any part of the trunk.

Deviate
Provides a graph editor to specify the deviation of the trunk from its original 
axis each time a branch is generated. Often it can be seen in nature that the 
trunk slightly changes its direction when a branch comes out of the trunk. 
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This fact can be simulated by assigning the “Deviate” function to your tree. 
This adds a lot of realism to the model. The amount of deviation can be 
specified independently for every part of the trunk.

Screw
Provides a graph editor to specify a rotation around the trunk’s longitudinal 
axis to the segments of the tree. This allows to rotate the branches around 
the trunk.The amount of rotation can be specified independently for every 
part of the trunk.

Branches > Number
Provides a slider to specify the number of branches generated by the 
multiplying “Tree” component.
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Branches > Arrangement
Provides a pull down menu to specify how branches and leafs are arranged 
along the trunk resp. a branch. The two main arrangement categories are 
perpendicular and lateral. Within these two categories the leafs or branches 
can be arranged in a free structure, in an alternating structure or in a 
pair structure. The following images demonstrate the different arrangement 
structures.

                             
Free perpendicular arrangement                     Free lateral arrangement

                             
Alternate perpendicular arrangement           Alternate lateral arrangement
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Pair perpendicular arrangement                       Pair lateral arrangement

Branches > Distribution
Provides a slider to specify the distribution of branches along the trunk. The 
spline defines a statistic function that distributes the number of branches 
specified in the “Branches > Number” section according to the maxima 
and minima of the spline-curve. A maximum creates a dense distribution of 
branches while in relation to this the minima receive a loose distribution. 
This function is only statistical which means that a linear curve always 
produces an equal distribution no matter how high the values of the curve 
are. The actual amount of branches remains the same as defined in 
“Branches>Number”.

Branches > Growth Scale
Provides a graph editor to specify a scaling factor for the branches 
generated by the parent component. The branches are scaled maintaining 
the thickness in their origin. This means their thickness is defined according 
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to the thickness of the trunk they are coming out of and they are only 
growing longer or shorter. The scaling factor can be assigned independently 
to any part of the branch and is passed on to the subsequent components.

Branches > Geometric Scale
Provides a slider to specify an overall scaling factor for the branches 
generated by the parent component which also has an effect on the 
thickness of the branches. The scaling factor can be assigned independently 
to any part of the branch and is passed on to the subsequent components. 
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Branches > Angle
Provides a graph editor to specify the inclination of the branches coming out 
of the parent component. The inclination value can be specified for any part 
of the parent component independently.

Branches > Dense
Provides a graph editor to specify the amount of branches generated by 
the following component. This means that this function – applied e.g. to the 
trunk of a tree – has an effect on the second branching level. The density 
value can be specified for any part of the child component independently.

Tropisms > Phototropism
Provides a graph editor to specify the degree of orientation of the selected 
component towards a virtual light source. The light source is always located 
above the model. This value can be specified for any part of the component 
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independently and is passed through to the child components.

Tropisms > Gravitropism
Provides a graph editor to specify the degree of orientation of the selected 
component towards the ground. This value can be specified for any 
part of the component independently and is passed through to the child 
components.

Tip: To change the longitudinal profile of a trunk open the “Primitive” tab in 
the “Parameter Editor”. The hull of the trunk is created by a “Tube” primitive. 
This primitive is a list of points defining the profile of the trunk. You can 
change this profile by setting the “Profile” function to “On” and then opening 
the spline editor. By manipulating this spline you can define the longitudinal 
profile of your trunk.
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Leaf Component

The “Leaf” component is dedicated to create leafs. It comes by default with 
the “Area” primitive which is indicated in the “Parameter Editor” and the 
“Hierarchy Editor” window as “none”. The “Leaf” component can also receive 
the “Square”, “Triangle Up” and the “Triangle Down” primitves. 

The default “Area” primitive allows for various deformations and adjustments 
of the leaf’s shape. These adjustments require a certain amount of polygons 
to deliver a smooth shape. Thus the default settings produce already a fairly 
complex geometry. Often this complexity is not needed and in these cases 
it is recomendable to use one of the triangle primitives or the “Square” 
primitive which produce only one resp. two polygons. When you intend to 
texturemap the leaves the actual shape of the leaf is defined by the texture’s 
alpha-mask and, thus it is not necessary to use a complex geometry for 
the shape definition. In a tree with many leaves the amount of polygons 
increases very fast and it can be desirable to reduce the complexity by using 
the triangle or square primitives.
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The difference between the “Leaf” component generating a “Square” or 
“Triangle” primitive and the “Simple” component generating them, is the 
location of the primitive’s origin. In combination with the “Simple” component  
the origin is in the middle of the primitive and in combination with the “Leaf” 
component the origin is on the edge of the primitive. So leaves generated 
by the “Leaf” component connect to a branch as real leaves do.

      
“Simple” component with        “Leaf” component with 
“Triangle Up” primitive         “Triangle Up” primitive

When the “Leaf” component is used with it’s default primitive, the “Leaf” tab 
of the “Parameter Editor” window shows all the parameters defining the leaf. 
The parameters explained below are only applicable in combination with the 
“Area” primtive. When other primitives are assigned to the “Leaf” component 
these parameters are displayed in the “Parameter Editor” window, but they 
do not have any effect. 
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The “Leaf” component has several parameters that make it easy to create 
different kinds of leafs.

Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.
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Segments
Provides a slider to specify the amount of segments the leaf consists of. The 
higher the amount the smoother the curves when you bend the leaf. 

Length
Provides a slider to specify the length of the leaf.

Curvature > Rotation X
Provides a double slider to specify a range value for the rotation of the leafs 
segments around the X-axis. Using the pull down menu left from the double 
slider you can assign a mathematical function that is used for the calculation 
of the intermediate values of the range definition.
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Curvature > Rotation Y
Provides a double slider to specify a range value for the rotation of the leaf’s 
segments around the Y-axis.
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.

Curvature > Rotation Z
Provides a double slider to specify a range value for the rotation of the leaf’s 
segments around the Z-axis.
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.
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Curvature > Translation Z
Provides a double slider to specify a range value for the translation of the 
leaf’s segments along the Z-axis.
Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition. By default the cosinus function is assigned.

Shape
Provides a pull down menu to specify the way the curvature of the leaf is 
defined. When “Range” is turned on, the curvature is defined in an implicit 
way. This means that a certain degree of rotation is specified for every 
segment of the leaf. The implicit definition specifies a range that starts with 
the first primitive that is generated and ends with the last primitive. 
When “Spline” is turned on the curvature is defined by a spline. In this case 
the “Parameter Editor” displays an “Edit” button instead of the double slider 
for the implicit definition.

Shape > Range
When “Shape > Range” is turned on, the “Parameter Editor” window 
provides a double slider to specify the translation value for the first segment 
of the leaf and the value for the last segment.
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Using the pull down menu left from the double slider you can assign a 
mathematical function that is used for the calculation of the intermediate 
values of the range definition.

Shape > Spline
When “Shape > Spline” is turned on, the “Parameter Editor” window 
provides an “Edit” button to open the spline editor window. By manipulating 
the spline you can define the outline of the leaf.
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Scale X
Provides a slider to specify a scaling factor for the leaf along the X-axis.

Scale Y
Provides a slider to specify a scaling factor for the leaf along the Y-axis. 
Scaling in this direction produces only a visible result when a profile is 
assigned to the leaf. This is done in the “Primitive” tab of the “Parameter 
Editor” window in the “Profile” section. This is only possible when the 
primitive of the leaf is an “Area” primitive. Manipulating the points of the 
point list generated by the “Area” primitive allows you to assign a three 
dimensional profile to the leaf.

                         
“Leaf” with a profile assigned                   “Leaf” with profile and “Scale Y”
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Tip:
If you want to have a smooth and irregular profile you have to increase the 
number of points of the point list primitive. This is done in the “Primitive” tab 
of the “Parameter Editor” window in the “Points” section.

 

Radial Deform
Provides a slider to specify a radial inclination of the leaf’s segments relative 
to the Z-axis. This function allows e.g. to create the heart like shape of leafs 
that is often seen in nature.
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Tropisms > Phototropism
Provides a graph editor to specify the degree of orientation of the leafs 
towards a virtual light source. The light source is always located above the 
model.
This value can be specified for any part of the component independently 
and is passed on to the child components.

Tropisms > Gravitropism
Provides a graph editor to specify the degree of orientation of the leafs 
towards the ground. 
This value can be specified for any part of the component independently 
and is passed through to the child components.

The usage of tropisms is a powerful way to imitate the phenomena that can 
nearly always be observed in natural growth. The effect of these parameters 
is global thus you do not have to deal with the single leaves but control 
them altogether.
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Revo Component

The “Revo” component generates a revolved volume. The default primitive 
of “Revo” is the “Tube” primitive. This point list is rotated by 360 degrees 
around the local Z-axis of the component and forms a closed surface.

Besides the common tabs “Basic”, Primitive” and “Material” the “Revo” tab of 
the “Parameter Editor” window provides just two different parameters.

Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.
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Shape
The “Shape” section provides only an “Edit” button to open a “Spline 
Editor” window. By manipulating the spline you can define the outline of the 
revolved volume.

The spline editor window displays a cross section of the revolved volume. 

Tip:
To increase the amount of points in the point list primitive for a smoother 
shape you have two possibilities. You can either go to the “Primitive” tab of 
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the “Parameter Editor” window and use the slider provided by the “Points” 
section. Or you use the “Resolution” slider at the bottom of the spline editor 
window shown above.

Hydra Component

The main purpose of the “Hydra” component is to multiply other 
components. By default it has no primitive assigned thus when you just 
create a new “Hydra” component nothing changes in the “Model View” 
window. To make something appear in the “Model View” window you 
either have to assign one of the geometry producing primitives (no point 
list primitives and no attractor primitive) or link another component that 
produces geometry to the “Hydra”
The “Hydra” component multiplies it’s child component (or the assigned 
primitive) in a circular structure around a center point.
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In the following image the “Hydra” component multiplies a subsequent 
“Horn” component.

 

Besides the common tab “Basic”, “Primitive” and “Material” the “Hydra” tab 
of the “Parameter Editor” window provides several functions to control the 
placement of the multiplied children. 

Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.
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Number
Provides a slider to specify the amount of instances generated by the 
“Hydra” component. A mathematical function can be assigned to the range 
definition

Fan
Provides a double slider to specify a range value defining the degree 
of rotation around the X-axis of the “Hydra”. The first value affects the 
first instance that is generated and the second the last instance that is 
generated. A mathematical function can be assigned to the range definition.
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Twist
Provides a double slider to specify a degree of rotation around the Z-axis of 
the “Hydra” for the first instance that is generated and for the last instance 
that is generated. A mathematical function can be assigned to the range 
definition.

Spin
Provides a double slider to specify a degree of rotation around the local 
longitudinal axis for the first instance generated by the “Hydra” and for the 
last instance generated by the “Hydra”.
A mathematical function can be assigned to the range definition.
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Scale
Provides a double slider to specify a scaling factor for the first instance  
generated by the “Hydra” and for the last instance generated by the “Hydra”.
A mathematical function can be assigned to the range definition.

PhiBall Component

The main purpose of the “PhiBall” component is to multiply other 
components. Like the “Hydra” component it has by default no primitive 
assigned. 
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The “PhiBall” component multiplies it’s child components (or the assigned 
primitive) in a spherical structure around a center point. 
In the following image the “PhiBall” component multiplies a “Box” primitive.

Besides the common tab “Basic”, “Primitive” and “Material” the “Hydra” tab 
of the “Parameter Editor” window provides several functions to control the 
placement of the multiplied children. 

Name
Indicates the name of the selected component. The name can be changed in 
the text field to rename the component.
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Number
Provides a slider to specify the number of instances generated by the 
“PhiBall” component. 

Fan
Provides a double slider to specify the angle in relation to the center point of 
the “PhiBall” for the first instance that is generated and for the last instance 
that is generated. 
A mathematical function can be assigned to the range definition.
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Angle
Provides a double slider to specify the placement of the instances on the 
sphere. By default they are arranged according to the golden section by the 
phi function that is assigned to the range definition. You can also assign 
other functions or none (id). 

Translation
Provides a double slider to specify a translation value along the Z-axis of 
the “PhiBall” for the first instance that is generated and for the last instance 
that is generated.
A mathematical function can be assigned to the range definition.



96

Xfrog 3.5 Reference Manual

Scale
Provides a double slider to specify a scaling factor for the first instance that 
is generated and for the last instance that is generated.
A mathematical function can be assigned to the range definition.

Influence
Provides a slider to specify a correction of the placement of the instances 
on the sphere. When the instances are scaled and they remain in their 
initial place, there will be a dense packing in areas where the instances 
are big and a loose packing in areas where the instances are small. 
By manipulating the “Influence” slider the placement can be corrected to 
achieve an even distribution of the instances on the sphere.
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Wreath Component

The main purpose of the “Wreath” component is to multiply other 
components. Like the “Hydra” component it has by default no primitive 
assigned. 
The “Wreath” component multiplies it’s child components (or the assigned 
primitive) in a ring structure around a center point. 
In the following image the “Wreath” component multiplies a “Box” primitive.

Besides the common tab “Basic”, “Primitive” and “Material” the “Wreath” tab 
of the “Parameter Editor” window provides three functions to control the 
placement of the multiplied children.
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Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.

Number
Provides a slider to specify the number of instances generated by the 
“Wreath” component.

Radius
Provides a slider to specify the radius of the ring where the instances are 
created.
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Attractor Component

The “Attractor” component is used to deform geometry. This kind of 
deformation uses invisible spheres that are pushed into the geometry to be 
deformed. It works like pressing the thumb into elastic clay.
For the deformation two things are needed, the “Attractor” component 
and at least one other component with the “Attractor” primitive assigned 
to it. The “Attractor” component is integrated into the hierarchy as the 
beginning of the deformation. All subsequent components can be affected 
by the deformation. The component with the “Attractor” primitive creates the 
invisible spheres that are pushed into the geometry.
All “Attractor” primitives that are children of the “Attractor” component are 
influenced by the settings of the parent component. The invisible spheres 
have to be linked to the hierarchy to be active. By displacing them, you can 
experiment with different deformations. Often you will use just one “Simple” 
component with the “Attractor” primitive assigned to create the spheres but 
you can also use e.g. a line of several “attractor” primitives multiplied by a 
“Horn” component. The “Attractor” primitive is used as any other primitive.  
The invisible spheres can be made visible in the “Model View” window by 
selecting “Model View > Display > Show/Hide Attractors”. 
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The image below shows a hierarchy constellation where attractor 
deformation is used to deform a tree. The two “Tree” components are 
deformed as they are children of the “Attractor” component. The “Simple” 
component in the separate branch of the hierarchy generates an “Attractor” 
primitive that deforms the “Tree” components (see images below).

Besides the common tab “Basic”, “Primitive” and “Material” the “Attractor” 
tab of the “Parameter Editor” window provides three functions to control the 
result of the deformation. 

Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.

Deform
Provides two radio buttons to switch between a deformation that deforms 
just the skeleton of the model or a method that deforms the hull (triangles) 
of the model.
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If the triangle deformation is switched on the hull (triangles) of the model 
will be deformed.

If the skeleton deformation is switched on only the skeleton of the model is 
deformed and the hull (triangles) remains untouched.

Separator
Provides a pull-down menu to switch between a deformation that maintains 
a coherent triangulation or that separates the different polygons. If the 
“Separator” is switched off the coherent triangulation is maintained. If 
“Separator” is switched on the triangles can be separated and thus the hull 
is not coherent any more.
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Hyper Patch

The “Hyper-Patch” component is a second way to deform geometry. It 
is a cube-shaped three-dimensional grid which can be distorted into all 
directions by dragging the control vertices. The model will be distorted 
according to the grid. This allows for a global deformation of the entire model 
without touching any of the model’s parameters.
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The “Hyper Patch” component is integrated into the model hierarchy 
preceding the part of the hierarchy that should be transformed. All 
subsequent components to the “Hyper Patch” component are deformed. 

Besides the common tab “Basic”, “Primitive” and “Material” the “Attractor” 
tab of the “Parameter Editor” window provides four functions to control the 
result of the deformation. 

Name
Indicates the name of the selected component. The name can be changed 
in the text field to rename the component.
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Patch
Provides an “Edit” button that opens an editor window where the grid can 
be adjusted. 
The Editor window provides a pull-down menu to specify the resolution 
of the grid. The resolution can be defined within the range from “linear” 
(produces four control vertices: one for every corner of the grid-cube), 
cubic (produces three control vertices on every edge of the grid-cube; i.e. 
it divides the cube into eight subcubes), quartic (produces four control 
vertices on every edge of the grid-cube) and quadratic (produces five 
control vertices on every edge of the grid-cube). 

   The grid resolution set to quartic

   The grid resolution set to cubic
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The three buttons “View X”, View Y” and “View Z” allow to constrain the 
display of the editor window to the three perspectives. 

     

Deform
Allows to switch between a deformation of the skeleton of the model or the 
hull (triangles). For a more detailed description see the “Deform” section in 
the description of the “Attractor” component.

Separator
Allows to switch between a coherent or separate triangulation of the 
model. For a more detailed description see the “Separator” section in the 
description of the “Attractor” component.  
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Primitives

Primitives are assigned to components to create the actual graphical output. 
Xfrog provides all common geometric objects and some specific primitives. 
There are several ways to assign a primitive to a component. They can be 
dragged from the “Libraries > Primitives” window onto a component in the 
“Hierarchy Editor” window, they can be assigned to a component that is 
selected in the “Hierarchy Editor” by double clicking the primitive icon in the 
“Libraries > Primitives” window or they can be selected from the “Primitive 
Type” pull down menu of the component’s “Primitive” tab in the “Parameter 
Editor” window.  
The primitives assigned to the components in the “Hierarchy Editor” can be 
made visible by switching the “Show” radio button in the top section of the 
window to “Primitives”.
The parameters controlling the primitives are available in the “Primitives” tab 
of the “Parameter Editor” window. 
All primitives have parameters for basic transformations like rotation, scale 
etc. in common.

None

The “None” primitive is in fact the absence of a primitive. It is assigned to a 
component when no geometry should be produced by this component. This 
is often the case when components are used to multiply other components. 
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Box

The “Box” primitive produces a cube. 

It provides the following parameters:



108

Xfrog 3.5 Reference Manual

Name
Indicates the name of the component the primitive is assigned to.

Primitive Type
Provides a pull down menu to select a primitive. The menu contains all 
primitives available in Xfrog.

Resolution
Provides a slider to specify the amount of points defining the primitive. 
To reduce the complexity of the model and to save calculation time, the 
default resolution of the primitives is low. If more detail is required it can be 
increased with this function.

                    
  Low primitive resolution                       High primitive resolution

Tip:
In order to achieve smooth deformations a high primitive resolution is 
required. Otherwise the surface of the deformed object will be jerky.

Transformation > Translation X
Provides a slider to specify a translation along the X-axis. This translates the 
primitive relative to the origin generated by the component. 

Transformation > Translation Y
Provides a slider to specify a translation along the Y-axis. 
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Transformation > Translation Z
Provides a slider to specify a translation along the Z-axis.

Transformation > Rotation X
Provides a slider to specify a rotation around the X-axis. This rotates the 
primitive relative to the origin generated by the component.

Transformation > Rotation Y
Provides a slider to specify a rotation around the Y-axis.

Transformation > Rotation Z
Provides a slider to specify a rotation around the Z-axis.

Transformation > Scale X
Provides a slider to specify a scaling factor in direction of the X-axis for 
the primitive. This scales the primitive independent from potential scaling 
applied by the component.

Transformation > Scale Y
Provides a slider to specify a scaling factor in direction of the Y-axis for 
the primitive.

Transformation > Scale Z
Provides a slider to specify a scaling factor in direction of the Z-axis for 
the primitive.

Lock Scale
Provides two radio buttons to switch an even scaling in all directions on 
or off.
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Sphere

Produces a sphere. The “Sphere” primitive has the same parameters as 
the “Box”.

Cone

Produces a cone. The “Cone” primitive has the same parameters as “Box”.
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Cylinder

Produces a cylinder. The “Cylinder” primitive has the same parameters as 
“Box”.

Torus

Produces a torus. 
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Additional to the parameters of “Box” the “Torus” primitive allows to edit the 
thickness of the torus.

Torus Minor

Provides a slider to specify the radius of the inner ring of the torus.

Square

The “Square” primitive produces a flat rectangular surface. It has the same 
parameters as “Box”
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Circle

Produces a flat circular surface. The “Circle” primitive has the same 
parameters as “Box”.

Tube

The “Tube” primitive is one of the point list primitives. It consists only 
of a certain number of points. When the “Tube” primitive is multiplied all 
instances are triangulated together in a triangle mesh. The points are placed 
in a closed ring so that multiplying them will create a volume. This can for 
example be used to create the hull of a horn or a trunk.
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Additional to the parameters of “Box” the “Tube” primitive has several 
parameters to control the triangle mesh.

Points
Similar to the “Resolution” slider the “Tube” primitive provides a slider to 
specify the amount of points in the point list.

Deformable
Provides two radio buttons to switch the triangle mesh between deformable 
and undeformable state. If “deformable” is turned on the triangle mesh can 
be deformed with an “Attractor” or “Hyper Patch”.

Profile
Provides two radio buttons to deform the triangle mesh with a profile or keep 
the default placement of the points. If “Profile” is set to 2D an “Edit” button is 
displayed to open a profile editor window.

Profile > Points
Provides an edit button to open a profile editor. In the editor window points 
can be dragged and inserted or removed either with the “Points” slider at 
the bottom of the window or with the “Points” slider in the upper part of the 
“Primitives” tab in the “Parameter Editor” window.
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Shading
Provides two radio button to switch the shading of the triangle mesh 
between flat shading and gouraud shading. This shading definition is 
independent from the global shading setting made in the “Model View > 
Shading” menu.

Separator
Provides two radio buttons to switch the triangle mesh from coherent 
triangulation to non-coherent triangulation. If “Separator” is turned on the 
different point list instances are triangulated together in a coherent triangle 
mesh. If “Separator” is turned off the point list instances are triangulated 
section by section and the triangle mesh can be broken for example when 
the component is deformed.

Triangulation
Provides two radio buttons to switch between simple and optimal 
triangulation. When “Triangulation” is switched to “simple”, every point in one 
point list instance is triangulated with the closest point in the next point list 
instance. When “Triangulation” is set to “optimal” a point is triangulated with 
the next point in the best available position to avoid triangle intersections.

Displacement
Provides a double slider to specify an offset value for the first point in the 
point list and for the last point in the point list. It is possible to assign a 
mathematical function to the range definition. By default this function is “rnd” 
which generates a random value within the range specified in the double 
slider. Random displacement gives the triangle mesh a rough surface. 
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Area  

The “Area” primitive is the second point list primitive in Xfrog. Different from 
the “Tube” it does not produce a closed ring of points but a row. Thus 
multiplying “Area” primitives will create a surface. 
The parameters of “Area” are the same as those of “Tube”.

  

Attractor

The “Attractor” primitive is used for deformation of geometry. It is a sphere 
that can be pushed into other components to deform them. The “Attractor” 
primitive can be assigned to any component. However, deformation is only 
possible in the combination of a component with the “Attractor” primitive 
assigned and the “Attractor” component. 
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As explained in the corresponding description, the “Attractor” component 
defines which part of the hierarchy can be deformed and activates all 
subsequent “Attractor” primitives. 

Additional to the parameters it has in common with “Box” the “Attractor” 
primitive provides some deformation specific controls.

Kernel
Provides a slider to specify the scope of the deformation within the 
deforming sphere. The deforming sphere has a range from the center to it’s 
border. In the center the deformation has it’s full strength and to the border 
the strength decreases. With this slider it is possible to modify the distance 
over which the decrease is produced. 
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Strength
Provides a slider to specify how strong geometry in contact with the 
“Attractor” will be deformed. If the slider is set to a negative value the 
deformation will have the opposite direction.

Direction
Provides a pull down menu to specify the direction of the deformation. 
It offers the following options: “Point”, “X-axis”, “Y-axis”, “Z-axis” and 
“HotSpot”. 
When “Direction” is set to “Point”, it will produce a circular deformation in all 
directions around the deforming sphere. 

When “Direction” is set to one axis, it will produce a deformation which is 
constraint to this axis.

              



  119

Xfrog 3.5 Reference Manual

When “Direction” is set to “Hot-Spot” the deformation is only produced by 
the center point of the deforming sphere. This hot spot can be translated 
independently.

  

Tip:
When using the attractor deformation always make sure that the component 
you want to deform provides enough geometry. If it consists e.g. only of one 
single triangle no deformation is possible. Thus in some cases you will have 
to increase - depending on the component you are using - the “Segements”, 
the “Points” or other parameters. 
Often the attractor is too small in it’s default settings to produce a useful 
deformation. In this case you have to scale the component to an appropriate 
size.
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Triangle Up

The “Triangle Up” primitive produces a flat triangular surface. It has the basic 
parameters (as “Box”) with the exception that it is not possible to change 
the resolution of the triangle. The primitive can be used to create leaves in 
cases where a simple solution with a low amount of polygons is required. 
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Triangle Down

The “Triangle Down” primitives is almost identical with the “Triangle Up” 
primitive. The only difference is that it points into the other direction.
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Appendix

Function Descriptions

This section shows a list of all functions that are provided in Xfrog with their graphs 
and their definition-ranges. The functions can be assigned to range definitions (see 
section “Parameter Editor Window/Controls/Double Sliders”) in order to change 
the calculation of the intermediate values between the start and the end value 
defined by the slider positions. A certain mathematical understanding is required 
to predict the result of the use of functions in a given context. Functions allow 
you to define shapes with a “mathematical perfection”. One simple example for 
the use of functions is the cos function that is assigned to the “Shape” definition 
of the “Horn” component by default. The function produces the smoothly curved 
conical shape of the Horn. 
Certain functions are only defined within a certain range of values and deliver no 
useful result beyond this definition range. The following graphs will give you an 
idea in which way the different functions remap the values of the sliders they are 
assigned to and within which range of values they are defined. The Input values 
specify the range of values that can be passed to the function and the Output 
values specify the range of values that are returned by the function.

Function: y = sin x
Description: sinus
Input values: -∞ to ∞
Output values: - 1 to 1

Function: custom
Allows you to create your own formula

Function: id
Description: identity
Leaves the values unchanged (y = x)

- π 1
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Function: y = cos x
Description: cosinus
Input values: - ∞ to ∞
Output values: - 1 to 1

Function: y = tan x
Description: tangens
Input values: - ∞ to ∞
Output values: - ∞ to ∞

-10 10

Function: y = asin x
Description: arcus sinus
Input values: - 1 to 1
Output values: - π to π

-1 π

Function: y = acos x
Description: arcus cosinus
Input values: - 1 to 1
Output values: - π to π

-1 π

- π 1
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Function: y = atan x
Description: arcus tangens
Input values: - ∞ to ∞
Output values: - π/2 to π/2

Function: y = sinh x
Description: sinus hyperbolicus
Input values: - 1 to 1
Output values: - π to π

-10 10

Function: y = cosh x
Description: cosinus hyperbolicus
Input values: - ∞ to ∞
Output values: 0 to ∞

-10 10

Function: y = tanh x
Description: tangens hyperbolicus
Input values: - ∞ to ∞
Output values: - 1 to 1

-2 2

- 2 2
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Function: y = exp x
Description: exponential 
  function to basis e=2.7182818

Input values: - ∞ to ∞
Output values: 0 to ∞

Function: y = log x
Description: logarithm to 
  basis e=2.7182818

Input values: 0 to ∞
Output values: - ∞ to ∞

-10 10

Function: y = sqr x
Description: square x (x2)
Input values: - 1 to 1
Output values: 0 to π

-1 1

Function: y = sqrt x
Description: square root of x
Input values: 0 to ∞
Output values: 0 to ∞

-1 1

- 10 10
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Function: y = ceil x
Description: the smallest integer
  greater or equal than x

Input values: - ∞ to ∞
Output values: - ∞ to ∞

Function: y = floor x
Description: the greatest integer
  smaller or equal than x

Input values: - ∞ to ∞
Output values: - ∞ to ∞

-10 10

Function: y = rnd x
Description: random number 
  between [-x..x]

Input values: - ∞ to ∞
Output values: 0 to ∞

-1
1

Function: y = rndabs x
Description: x*abs(rnd(1))
Input values: - ∞ to ∞
Output values: 0 to ∞

-1 1

- 10 10
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Function: y = abs x
Description: abs(x)
Input values: - ∞ to ∞
Output values: 0 to ∞

Function: y = phi x
Description: x*1.618034
Input values: - ∞ to ∞
Output values: - ∞ to ∞

-1 1

Function: y = smooth x
Description: smooth clamp in 0..1
Input values: - ∞ to ∞
Output values: 0 to ∞

-2 2

Function: y = clamp x
Description: clamp in 0..1
Input values: - ∞ to ∞
Output values: 0 to ∞

-2 2

- 1 1
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Function: y = pi x
Description: x*3.1415927
Input values: - ∞ to ∞
Output values: - ∞ to ∞

Function: y = rad x
Description: x*3.1415927/180
Input values: - ∞ to ∞
Output values: - ∞ to ∞

Function: y = ftime x
Description: time of the keyframe sequence (between 0 and 1)
Input values: - ∞ to ∞
Output values: 0 to 1

Function: y = frame x
Description: number of the current frame of the keyframe sequence
Input values: - ∞ to ∞
Output values: 0 to ∞

Function: y = iter x
Description: number generated by the last iterating component
Input values: - ∞ to ∞
Output values: - ∞ to ∞


